(From Tutorials:  select Analysis Services.  Note:  SSAS is SQL Server Analysis Services.)
SQL Server 2005 includes tutorials to help you understand SQL Server technology and get started with your projects. The following table describes the tutorial areas. Click on the link to go to the overview page for the tutorials in each technology.
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Categories
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	SQL Server Tools

Learn to use the SQL Server tools and utilities.
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	Analysis Services

Learn to use Analysis Services features.
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	Data Mining

Learn to use Data Mining features.


	[image: image5.png]



	Integration Services

Learn to use Integration Services features.
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	Notification Services

Learn to use Notification Services features.


	[image: image7.png]



	Reporting Services

Learn to use Reporting Services features.



	
	


STEP 1:To create a new Analysis Services project
In the following task, you open Business Intelligence Development Studio and create a new Microsoft SQL Server 2005 Analysis Services (SSAS) project named Analysis Services Tutorial, based on the Analysis Services Project template. A project is a collection of related objects. Projects exist within a solution, which includes one or more projects.

1. Click Start, point to All Programs, point to Microsoft SQL Server 2005, and then click SQL Server Business Intelligence Development Studio.

The Microsoft Visual Studio 2005 development environment opens.

2. Close the Start Page tab. On the File menu of Visual Studio, point to New, and then click Project. 

You can use Business Intelligence Development Studio to create several different types of projects, either from templates that are installed with Visual Studio or from templates that you define. The templates that are installed depend on which Microsoft SQL Server 2005 components you install.

3. In the New Project dialog box, select Business Intelligence Projects in the Project types pane, and then select Analysis Services Project in the Templates pane.

Notice the default project name, the default solution name, and the default project location in the bottom of the dialog box. By default, a new directory will be created for the solution.

4. Change the project name to Analysis Services Tutorial, which also changes the solution name, and then click OK.

You have successfully created the Analysis Services Tutorial project, based on the Analysis Services Project template, within a new solution that is also named Analysis Services Tutorial.

The following graphic shows the Analysis Services Tutorial project within the Visual Studio development environment. (This is the Solution Explorer view.)
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Business Intelligence Development Studio Components

When a new Analysis Services project opens, Solution Explorer and the Properties window are visible and docked. The Server Explorer, Toolbox, Task List, Error List, and Output windows are hidden and docked. Hidden windows appear on the left, bottom, or right side of the Visual Studio development environment, depending on where they are docked. To view a hidden window, position your pointer in the hidden window and it will reappear. To hide or unhide a window, click the Auto Hide button. If you accidentally close an open window, you can reopen it from the View menu. 

The following table describes the windows that are visible when you open a new Analysis Services project.

	Solution Explorer 
	Contains a tree view of the objects in the solution. A solution can contain multiple projects; each project contains one or more items. A project contains folders for each type of object that can be defined for the project, based on information that is contained in the template from which the project was created. An Analysis Services project contains the following folders: Data Sources, Data Source Views, Cubes, Dimensions, Mining Structures, Roles, Assemblies, and Miscellaneous.

	Properties 
	Contains the properties collection for a selected object.


STEP 2:  To define a new data source
1. In Solution Explorer, right-click Data Sources, and then click New Data Source.

The Data Source Wizard opens.

2. On the Welcome to the Data Source Wizard page, click Next. 

The Select how to define the connection page appears. On this page, you can define a data source based on a new connection, based on an existing connection, or based on a previously defined data source object. A previously defined data source object is an existing data source definition within the current project or within another project in the current solution. In this tutorial, you will define a new data source based on a new connection.

3. On the Select how to define the connection page, click New. 

The Connection Manager dialog box appears. In this dialog box you define connection properties for the data source. A connection manager is a logical representation of the connection that will be used at run time. For example, a connection manager includes a connection string property that you set at design time; at run time, a physical connection is created by using the values in the connection string property.

4. In the Provider list, verify that Native OLE DB\Microsoft OLE DB Provider for SQL Server is selected.

Analysis Services also supports other providers, which are displayed in the Provider list.

5. In the Server name text box, type localhost.

To connect to a named instance on your local computer, type localhost\<instance name>. When you deploy the project to a particular instance of Analysis Services, the Analysis Services engine will connect to the Adventure Works DW database in the default instance of Microsoft SQL Server on the computer where the instance of Analysis Services resides. If you specify a particular computer name or IP address when you define a data source, the project or the deployed application will make the connection to the specified computer instead of to the local computer. The Analysis Services Deployment Wizard lets you specify the actual server name for the source data at deployment time.

6. Verify that Use Windows Authentication is selected. In the Select or enter a database name list, select AdventureWorksDW. 

The following image shows Connection Manager with the settings that you have defined up to this point.
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7. Click OK, and then click Next.

The Impersonation Information page appears. On this page of the wizard, you define the security credentials for Analysis Services to use to connect to the data source. In this tutorial, you will select the Analysis Services service account because this account has the necessary permissions to access the Adventure Works DW database.

8. Select Use the service account, and then click Next. 

The following image shows the Completing the Wizard page that appears.
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9. On the Completing the Wizard page, click Finish to create the new data source with the name Adventure Works DW. 

The following image shows the new data source in the Data Sources folder in Solution Explorer.
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Note: 

	To modify the properties of an existing data source, double-click the data source in the Data Sources folder to display the data source properties in Data Source Designer. 


You have successfully defined the Adventure Works DW data source for the Analysis Services Tutorial project. 

After you define the data sources that you will use in a Microsoft SQL Server 2005 Analysis Services (SSAS) project, the next step is generally to define a data source view for the project. A data source view is a single unified view of the metadata from specified tables and views that the data source defines in the project. Storing the metadata in the data source view enables you to work with the metadata during development without an open connection to any underlying data source. 

In the following task, you define a data source view that includes five tables from the Adventure Works DW data source. 
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STEP 3:  To define a new data source view

1. In Solution Explorer, right-click Data Source Views, and then click New Data Source View.

The Data Source View Wizard opens.

2. On the Welcome to the Data Source View Wizard page, click Next. 

The Select a Data Source page appears. Under Relational data sources, the Adventure Works DW data source is selected. 
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Tip: 

	To create a data source view that is based on multiple data sources, you first define a data source view that is based on a single data source. This data source is then called the primary data source. You can then add tables and views from a secondary data source. Heterogeneous queries require that at least one data source be a Microsoft SQL Server data source. 


3. Click Next. 

The Select Tables and Views page appears. On this page, you select tables and views from the list of objects that are available from the selected data source. You can filter this list to help you in selecting tables and views.

4. In the Available objects list, select the following tables by holding down the CTRL key to select multiple tables: 

· DimCustomer
· DimGeography
· DimProduct
· DimTime
· FactInternetSales
5. Click > to add the selected tables to the Included objects list.

The following image shows the Select Tables and Views page after you have added tables to the list of included objects.

[image: image16.png]=loix|

Select Tables and Views o
Select objects from the relationsl database to be included i the data source.
Avalable objects Included objects:
Name Type | A Nome Type
dbo.Adventurewo... Table dbo.DimCustomer  Table
{2 dbo.DimAccount Table > | | Jdbo.DimGeography  Table

D dbo.oimCurrency  Table
(0 dbo.DimDepartme...  Table
(D dbo.Dimmployee  Table
(X dbo.Dimorganization  Table
(2 dbo.DimProductCa... Table

dbo.DimProduct Table
dbo.DimTime Table
dbo.Factintemet... Table

[ dbo.DimProductsu... Table >
(X dbo.DimPromotion  Table
[ dbo.DimRessller Table <<

7 dbo.Dinaleskeason Table 7l —

Fiter d A Relted Tables

T~ Show system gbjects

e e oee ]

/)





6. Click Next, and then click Finish to define the Adventure Works DW data source view. 

The data source view Adventure Works DW appears in the Data Source Views folder in Solution Explorer. The contents of the data source view also displays in Data Source View Designer in Business Intelligence Development Studio. This designer contains the following elements:

· A Diagram pane in which the tables and their relationships are represented graphically.  If the relationships are not defined you can define them by dragging and dropping just like you would in MS Access.  Unlike Access, this view expects you to drag from the foreign key (Fact Table) to the primary key (Dimension Table).
· A Tables pane in which the tables and their schema elements are displayed in a tree view.

· A Diagram Organizer pane in which you can create subdiagrams so that you can view subsets of the data source view.

· A toolbar that is specific to Data Source View Designer.

The following image shows the Adventure Works DW data source view in Data Source View Designer.

[image: image17.png]Analysis Services Tutori

Ble Edt Vew Projct Buld Debug

-1 IEEY Y

rosoft Visual Studi

Fomat  Database  Data Source View

9. - g

5| b Development

Tools Window Community  Help

- Default - i

T Dimpraduct oo o

P Producey C
Produlamatekay
ProduSbesegor,
Weightrifezsurs.

SaabniMessursCode

[—

3¢ Adventure Wor..+.dsv [Design] | bjctBrowser s x
3
Bllaal@sms|x(@a-
g 68 Soltion ‘Analysis Services Tutorel (1 project)
| iagram Orgenizer ] ComyRegincods 21 57 7, anatyss services Tutorial
[ | Erohbenmm g
2 || e <l Tables> SpanihCountryRegionNa. B [ Data Sources
% FraiCoummyhasoniond 3 Adventure Works OW.ds
¥ oo 5 [ Dsta Source views
g SeecTertoryKey 2 Adventure Works D dsv
g [ re
S 2 Dimensions
- 2 Mg tructures
& Roes
ETTTTETS e B Assembles
rabes S Seoriatumter 2 Tinete & Micelaneous
e — S o Fuioae

=] DmCustomer (dbo.DimCust Produckey Daytiur

(] pimGeography (dbo.DimGec OrderDatekey. l Enqhxh: [Pester |

(] pimProduct (dbo.DimProduc DueDatakey Spanishl

‘ShipDateKey FrenchCy iventure Works atasourceview -
(] Dinine (dbo.Dinine) ooty [ 7| Doyr | Adventure Works DW Datasourcets
FactnermetSales (dbo.Fac Pty oo | o2
B < Gty - =
SalesTenitoryKey Englishiy Data Source Adventure Works DW
Descrption
Nome Advrture Worls OW

o

NemeMatchingCrieria | (none)

Name

Trekcit] [eworum] |
Ready





7. Click the Maximize button to maximize the Microsoft Visual Studio development environment. 

8. On the toolbar across the top of Data Source View Designer, use the Zoom icon to view the tables in the Diagram pane at 50 percent. This will hide the column details of each table.

9. Click the Auto Hide button, which is the pushpin icon, on the title bar of Solution Explorer. 

Solution Explorer minimizes and changes to a tab along the right side of the development environment. To view Solution Explorer again, position your pointer over the Solution Explorer tab. To unhide Solution Explorer, click the Auto Hide button again. 

10. Click Auto Hide on the title bar of the Properties window, if the window is not hidden by default. 

You can now easily view all the tables and their relationships in the Diagram pane. Notice that there are three relationships between the FactInternetSales table and the DimTime table. Each sale has three dates associated with the sale: an order date, a due date, and a ship date. To view the details of any relationship, double-click the relationship arrow in the Diagram pane.

The following image shows the Diagram pane in Data Source View Designer.
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You have successfully created the Adventure Works DW data source view, which contains the metadata from five tables in the Adventure Works DW data source. In the next lesson, you will define the initial version of the Analysis Services Tutorial cube from these five tables.
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Tip: 

	To add tables to an existing data source view, right-click the Diagram pane or the Tables pane, and then click Add/Remove Tables. For simplicity, add only the tables and views to the data source view that you intend to use in the project. 


STEP 4:  To Modify Default Table Names (see tutorials).   Access allows you to use “friendly names” or aliases that are different from the data administrator names. 
